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 簡介：歡迎使用 EndNote 

EndNote 簡介 

� EndNote 是一個線上查詢工具 

EndNote 提供一個簡易的方式查詢線上書目資料庫，並且得到這些參考文獻

直接地進入 EndNote 中。(EndNote 也可以匯入來自於不同線上資料庫，CD- 
ROMs 所儲存的資料) 

� EndNote 是一個參考文獻和圖像的資料庫 

EndNote 專門從事針對您個人 Library 參考文獻的排序、管理、查詢。您可

以組織圖片：包含圖表和方程式，每個圖片您可以給予其特殊的標題說明和

關鍵字。 

� EndNote 是一個參考書目和手稿製作者 

EndNote可以透過Cite While You Write TM 特色在Microsoft Word中使用編排

引用格式、圖表等功能。當您在手稿中插入引用格式時，注意參考文獻、圖

表清單會隨著增加。 

關於 EndNote 試用版和 EndNote 瀏覽器 

如果您使用的是 EndNote X2 試用版，那您只能從您第一次開始執行 EndNote 程

式算起 30 天可以使用 EndNote 所有功能。當 30 天過後，您的 EndNote 試用版

將會轉換成有功能限制的 EndNote 瀏覽器。 

關於使用手冊 

這本手冊將為您簡介如何使用 EndNote 來儲存參考資料和撰寫文章，讓您快速瀏

覽、了解 EndNote 的重要功能與特色。 
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客戶服務 

� EndNote 使用手冊和線上輔助說明 

EndNote 使用手冊：完整的 EndNote 使用手冊您可以再 EndNote 資料夾中找

到。或是在開始→程式集→EndNote→EndNote Manual，開啟完整的手冊。 

EndNote 線上輔助說明：您可以在 EndNote 程式中的 Help 選單中點選

Contents 瀏覽不同的說明主題。 

� 客戶服務 

(1) Sales Information 
Phone: (760) 438-5526 (country code is 01) 
Fax: (760) 438-5573 (country code is 01) 
Web/Email: http://www.endnote.com/encontact.asp 

(2) Customer Service (Orders, Billing, and Shipping) 
Phone: (800) 336-4474 (country code is 01) 
Fax: (215) 386-2911 (country code is 01) 
Web/Email: http://www.endnote.com/encontact.asp 

� 技術支援 

當您使用 EndNote 遭遇到問題時可以聯絡技術支援。當您連絡時，請清楚描

述問題和使用的 EndNote 版本、Windows 系統、Word 版本。您可以從 EndNote
程式中，Help 選單中選擇 About EndNote 了解您使用的 EndNote 版本。 

Our hours are Monday–Friday, 8:00 am – 5:00 pm Pacific Time. 
Phone: (408) 987-5609 (country code is 01) 
Web/Email: http://www.endnote.com/encontact.asp 

� EndNote 網頁 

EndNote 網頁包含技術支援、有用的更新資料、EndNote 最新版本資訊。您

也可以從 Support and Services 發現最近更新的 Style、Filters、Connection 檔

案。您也可以從 EndNote 程式中的 Help 選單中選擇 EndNote Program Updates
更新。 

� EndNote –討論區 

如果您想加入像您一樣的 EndNote 使用者討論區。您可以到 EndNote 網頁 
http://www.endnote.com 點選 Support and Services，然後將頁面往下移動，
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您可以看到 EndNote Discussion Forum。您可以在 Join the EndNote Discussion 
Forum 點選 More 進入到 EndNote 討論區。 

EndNote X2 新功能 

� Tab 視窗 
將Preview與Search標籤同時放在Tab視窗中，若要開啟一個查詢功能時，

點選Search標籤按鈕即可 
� Online Search 群組 

在群組視窗中，將 Connection file 清單中常選取的網站或資料庫加到 Online 
Search 群組中，可快速地開啟一個查詢 

� Custom Groups & Smart Groups 群組 
使用 Custom Groups 群組瀏覽和管理 Library 內子群組文獻。透過 Smart 
Groups 功能客製建立一個自動查詢的檢索策略 

� 增加參考文獻格式 
Aggregated Database、Blog、Catalog、Pamphlet(例如像藥物通告)、Serial(在
一個 Collection 連續出版書籍)、Standard 

� 查詢 Full Text 
查詢 EndNote 參考文獻的全文，會以 PDF 或是 URL 方式提供 

� 標示日期 
參考文獻現在會自動標示日期資訊。每筆參考文獻都包含” Added to Library 
date”和”Record Last Updated date”。EndNote X1 之前版本的參考文獻，當以

EndNote X2 開啟後，Added to Library date 將會以空白呈現，Record Last 
Updated date 將會以 EndNote X2 開啟的日期標示。當安裝 EndNote X2 後，

之前 EndNote 版本中的 Last Modified Date 將會被重新命名為 Custom 8。(既
存的參考文獻類型設定將會被保留) 

� 新增 Email Compress Library 功能 
提供原本的 Create Compress Library 功能和新增 Create & Email Compress 
Library，新增將儲存的 Compress Library 以 Email 附檔功能寄出 

� Library 摘要資訊 
從 EndNote Tools→Library Summary，可以取得此 Library 摘要統計資訊 

� Record 摘要資訊 
從 EndNote References→Record Summary，可以取得此記錄摘要統計資訊 
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第一章：EndNote 安裝 

安裝 EndNote 前 

程式需求 

� 系統需求： 
Windows XP，with Service Pack 2 
Windows Vista 

� 硬體需求：個人 PC 需在 Pentium 450 MHz 以上、256 MB 以上的 RAM、硬

碟空間至少要有 180 MB 以上可用空間。 
� 如果需使用 Online Search 功能連結網站或資料庫查詢，也需要有網路連結

功能。 

文書處理軟體 

至 2008 年 6 月為止，Windows 系統中的 EndNote 可以支援以下文書處理軟體。 
� Microsoft Word for Windows 2003, 2007 
� 建立 RTF 檔案使用的文書處理軟體包含 Microsoft Word, WordPerfect, 

OpenOffice, StarOffice, WordPad 
� Open Document Format(ODT)文件建立跟著 OpenOffice Suite 
 
Microsoft Word： 
EndNote 安裝 Cite While You Write 功能結合在 Microsoft Word。Word 2007 的 Cite 
While You Write 功能呈現在 EndNote 標籤下。如果使用先前 Microsoft Word 版

本，您可以從 Word 的工具選單中找到 EndNote 選單。當開啟 Word 文件時，您

可以透過在 Word 中的 EndNote 功能選單編排引用格式和建立參考書目。在您離

開文書處理軟體前，您可以在文件中 format, unformat, reformat。EndNote 支援安

裝在您電腦中的 Microsof Word，Cite While You Write 功能在您安裝 EndNote 時

就會自動安裝。 
為了 Cite Wile You Write 功能的完整安裝有以下兩點注意事項： 
� Microsoft Word 2000, XP, 2003, 2007 必需先安裝在您的電腦中，之後再安裝

EndNote 程式 
� EndNote Cite While You Write 功能必須在 Word Startup 資料夾中有安裝成

功。 
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RTF和ODT文件： 
除了 Word 之外的文書處理軟體，寫好您的文章，在文章中插入引用文獻，如果

檔案格式是除了 ODT 文件以外的格式，請儲存成 RTF 檔案格式。然後使用

EndNote 的格式化文件特色，從 ODT 和 RTF 檔案格式化註釋和參考文獻。詳細

請見 EndNote Manual 第 12 章有完整的說明。 

EndNote 安裝在 Palm OS 需求 

如果您的電腦有安裝軟體可以允許同時使用Palm OS®手持裝置，EndNote安裝程

式將會詢問您是否要安裝EndNote在Palm OS上。 

執行 EndNote 在 Palm Operating System 上需要： 
� 手持裝置 
� Palm Operating System 4.x 或更新版本 
� Serial 或 USB 傳輸對於 HotSync 操作 
� 16 MB RAM 
關於如何在手持裝置 Palm OS 使用 EndNote，請開啟 EndNotet 程式，在 Help 選

單中選擇 Contents。閱讀線上說明中的”Palm OS Handhelds”。 

安裝 EndNote 

安裝步驟 

1. 首先先確認您登入本機電腦的權限為管理者權限。並且確認沒有任何程式正

在執行。 
2. 從貴單位網頁上下載 EndNote X2 壓縮程式 

 
3. 解壓縮該程式後出現兩個檔案：ENX2Inst.msi 和 License.dat 
4. 按下 ENX2Inst.msi 開始進行安裝，安裝前請先關閉 Word 出現＂Welcome to 

the EndNote X2 Installation＂，按下＂Next >＂ 
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5. 出現”Read Me Information”，按下”Next > 
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6. 出現”Palm Read Me Information”，按下”Next >” 

 

 
7. 出現” Windows Mobile Read Me” ，按下”Next >” 
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8. 出現”Select Installation Type”，按下”Next >” 

 

 
 
9. 出現”Select Destination”，預設路徑為 C:\Program Files\EndNote X2\，按

下”Next >” 
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10. 出現”Ready to Install the Application”，按下”Next >” 
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11. 出現”EndNote X2 has been successfully installed.”，安裝完畢，如欲執行

EndNote 請按下”Run”，或按下”Finish”結束安裝 

 
 

客製化安裝選項 

雖然我們強烈建議您選擇 Complete 安裝選項安裝 EndNote，但是 Custom 選項可

以適用於您如果是硬碟空間較低或是您如果需要重新安裝某些 EndNote 構成要

素。 
建立一個客製化安裝 
1. 依照前述安裝步驟請見第 6 頁。 
2. 在安裝對話框中選擇 Custom 安裝選項。 
3. 當您看到對話框中的標題 Select Components，請閱讀下方選項，Select 

Components 是決定哪些安裝您要選擇或是不要選擇。 
在安裝完整 EndNote X2 後安裝 EndNote 構成要素 
1. 啟動安裝執行程式。 
2. 在 Application Maintenance 對話框中閱讀下方選項，Select Components 是決

定哪些安裝您要選擇或是不要選擇。 
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選擇組成項目 

以下有幾個 EndNote 構成要素分類是可以跟隨著 EndNote 一起安裝。 
1. EndNote Application 
� EndNote Program 
� Sample Files 
� EndNote Help 
� PDF Manual 

2. Word Templates/Add-ins: 
� Add-in for Microsoft Word 
� Templates for Microsoft Word 

3. Styles 
Styles 是建立參考書目，此依照類型區分 

4. Connections 
Connections 可以直接從線上資料庫或網站取得參考文獻，此類型依照資訊服

務提供者區分 
5. Filters 

Filter 是針對匯入純文字檔的參考文獻功能，此類型依照資訊服務提供者區分 
6. Spelling Dictionaries 

EndNote 也提供字典功能針對拼字檢查 
7. EndNote for Palm OS ® 

這個功能是針對 Palm 作業系統使用 EndNote 
 
 
選擇或是取消安裝選項 
點選每個分類旁的加號符號以呈現詳細選項清單。針對每個分類或是子分類，點

選在名字旁邊的三角形選擇即將安裝的選項。這些選項可能包含如下： 
� Will be installed on local hard drive. 
� Entire feature will be installed on local hard drive. 
� Will be installed to run from network. 
� Entire feature will be installed to run from network. 
� Feature will be installed when required. 
� Entire feature will be unavailable. 

從舊版 EndNote 升級安裝 

在您開始安裝前，如果您不想被重新安裝的檔案覆蓋過去，請先備份任何客製化

的 Styles、Import Filters、Connection Files。當它不需要的時候，我們建議您在安
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裝 EndNote X2 前移除任何舊版的 EndNote。安裝方式請見第 6 頁安裝說明。預

設，EndNote X2 安裝在 C:\Program Files\EndNote X2 資料夾。 

備份或取代檔案 

如果安裝時發現在安裝資料夾中有舊版 EndNote，它將提醒並給於予您兩個選

項。如果您將繼續安裝 EndNote X2 在您現存的 EndNote 資料夾中，安裝過程中

將移除舊版 EndNote 應用和 Word 文書處理軟體的支持檔案。您應該從舊版

EndNote 中選擇您需要的 Styles、Filters、Connection Files。不管選擇哪個選項，

您的 Library 將會被刪除；也不會有任何 EndNote 檔案在 EndNote 資料夾中。 
� 備份舊有檔案 

EndNote 提供完整更新安裝的 Style、Filter、Connection Files。但是如果您想

保留任何有修改過的檔案，並且在 EndNote X2 中使用，您應該必須要選擇

此選項。選擇後 EndNote 會在 EndNote 資料夾中建立一個 Backup 資料夾。

並且所有來自於舊版 EndNote 的 Style、Filter、Connection Files 被複製在此

資料夾中。當 EndNote X2 安裝完畢，您必須移動要使用的 Style、Filter、
Connection Files 至 EndNote X2 的 Style、Filter、Connection Files 資料夾中。 

� 移除舊有檔案 
如果您選擇此項目，安裝程式將會取代舊版 EndNote 中所有 Style、Filter、
Connection Files，安裝成 EndNote X2 的版本。如果您想保留客製化的 Style、
Filter、Connection Files，請不要選擇此項目。 

開啟和轉換舊有 EndNote Libraries 

EndNote X2 會自動轉換 EndNote 8 之後版本的 Library。 
 
轉換舊有 EndNote Library 
1. 開啟 EndNote 
2. 從 File→Open→Open Library 
3. 開啟檔案對話框選擇舊有的 Library，點選開啟。 

EndNote 將會提醒選擇的 Library 是在舊版 EndNote 建立的，將會請求許可

轉換它。 
4. 點選 OK 轉換舊有 Library。命名新的 Library 和存檔。轉換功能將會從

EndNote 8 之後版本原始 Library 複製一個新的 Library，並且原封不動保留

原始 Library 檔案。 
注意：EndNote X2 Library 無法開啟 EndNote 8 之前的版本。 

使用舊 Style、Filter、Connection Files 

您也許在舊版 EndNote 已經建立客製化的檔案內容。EndNote X2 可以使用從

EndNote 4.01~X 版所建立客製化的 Styles、Filters、Connection Files。如果您一旦
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在 EndNote X2 中編輯這些檔案並存檔，它將轉換成 EndNote 8 之後版本的格式。 

確認您的安裝 

確認 EndNoe 

從開始→程式集→EndNote→EndNote Program。開啟 EndNote 程式後將會出現開

啟 Library 的對話框，請選擇 Cancel 取消。如要確認 EndNote 版本，從 Help→

About EndNote 確認。 

確認 Microsoft Word 

如要檢查確認 Cite While You Write 功能是否正確安裝，請開啟 Word。在 Word 
2003，點選工具選單您將會看到 EndNote X2 操作選項。 

 

 
 
在 Word 2007 則您可以看到 EndNote 標籤 

 

 

自動更新檔案 

當有新增程式時您可以自動更新 EndNote X2。 
1. 開啟網路連線 
2. 從 EndNote 程式中→Help→EndNote Program Updates 
選取後會出現如下圖的安裝精靈，請依照步驟更新安裝即可。 
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注意：您也可以從EndNote官方網站http://www.endnote.com 安裝最新檔案。 

移除 EndNote 

從開始→設定→控制台→新增移除程式→EndNote X2→選擇移除 即可移除

EndNote X2 程式。 
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第二章：EndNote 簡介 

這個章節包含基本的操作 EndNote。特別地您將學到以下項目 
� 開啟 EndNote 和開啟 EndNote Library 
� 排序參考文獻 
� 在 EndNote Library 選擇、開啟、關閉參考文獻 
� 儲存參考文獻至群組中 
� 離開 EndNote 程式 

開啟 EndNote  

選擇 EndNote program 然後開啟 Sample library： 

1. 從開始 → 程式集 → EndNote → EndNote Program。如果您是第一次使用

將會出現以下對話視窗，提供您選擇開啟一個EndNote Library。 
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注意： 如果規定預設Library自動開啟，預設Library將會取代此對話框優先開

啟。如果此狀況發生，請關掉Library，從File→Open選擇範本Libray檔案。 

2. 選擇EndNote Program後，跳出一個視窗，請點選Open an existing EndNote 
library 

3. 接著開啟EndNote reference library 
♦ 在下拉選單中選擇Sample_Library.enl，接著點選OK 
♦ 如果Sample_Library.enl沒有出現在下拉選單中，點選Browse按鈕，系統會

跳出一個視窗讓您選擇，開啟Reference library 
♦ 您也可以使用檔案總管或我的電腦，點選C磁碟 → 點選Program Files資

料夾 → 點選EndNote資料夾 → 點選Examples資料夾 → 點選

Sample_Library.enl，系統就會直接開啟EndNote reference library目錄下的

Sample_Library.enl範本檔案。其路徑為：C:\Program 
Files\EndNote\Examples\Sample_Library.enl 

♦ 另外您也可以使用EndNote reference library下的File menu來開啟檔案。 

 

EndNote Library 視窗 

開啟Sample Library時，您會看到EndNote Library視窗呈現所有的參考文獻。 
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移動欄位調適到適合的寬度

1. 參考文獻清單視窗 
在EndNote Library的視窗中呈現多個欄位清單。預設第一欄是以迴紋針呈現

有在File Attachments欄位中有附加檔案的參考文獻。接著為第一作者的名字

(Author)、年代(Year)、標題(Title)、期刊名稱(Journal name or secondary title)、
參考文獻類型(Reference Type)、網址(URL)和最後更新日期(Last Updated)。
在Library視窗中呈現的欄位您可以在EndNote Preferences中（點選 Edit → 
Preferences）修改視窗中呈現的欄位。 

2. 群組視窗 
視窗左方呈現參考文獻的不同群組分類。在一個新的library中，預設只有All 
Reference的群組。 

3. Tab視窗 
EndNote Library右下方的Tab視窗可以在Preview中預覽格式化的參考文獻，在

Search中查詢EndNote Library的資料或是線上資料庫。 

預覽參考文獻 

您可以透過Tab視窗的Preview看到更多您所點選參考文獻的資料。 
1. 如果在EndNote Library視窗中沒有看到Tab視窗，第一個步驟請點選Show Tab 

Pane開啟預覽視窗 
2. 點選Geophysical Research Letters這筆參考文獻。在預覽視窗中您可以看到該

筆參考文獻的輸出的書目格式（output style）。EndNote的output style可依照不

同期刊和其他出版品建立參考書目。這個Style將決定您的參考文獻當列印、

輸出、預覽和建立參考書目時呈現的樣式 
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3. 如欲選擇不同的格式，可從工具列的下拉選單中選擇欲呈現的輸出格式。例

如選擇Numbered格式 

 
預覽視窗中只會顯示一筆參考文獻；如果選擇多筆參考文獻，也只會呈現第一

筆選取的參考文獻。在預覽視窗中的參考文獻可以隨時改變其呈現格式。 

 

預覽視窗 Show/ Hide  

Tab Pane 按鈕 

點選Show Tab Pane出現預覽視窗後，Show Tab Pane按鈕會變成Hide Tab Pane；

如果您不要預覽視窗，可以點選Hide Tab Pane，系統會隱藏預覽視窗。 

參考文獻排序 

參考文獻可以簡單的點選欄位標題作排序（如依照作者、年代、標題進行排序）。

排序的步驟如下： 
1. 點一下作者（Author）欄改變當下作者的排序方式，從依照字母遞增到遞減

排序 
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注意：這個例子呈現包含中文、日文的字元。EndNote使用Unicode編碼特殊字元，

所以資料可以簡易的轉換在平臺、程式和語言中。如果您看到亂碼的話，請將

EndNote顯示改成Unicode字型。 
2. 點一下年代(Year)的標題欄，視窗中的參考文獻將依年代遞增排序 
3. 再點一下年代的標題欄，視窗中的參考文獻則改為依年代遞減排序 
4. 如點選作者、題名，視窗中的參考文獻則會依字母依序排列。 

選擇和開啟一筆參考文獻 

您必須先選擇確認一筆要開啟的參考文獻。有很多方法可以選取參考文獻，直

接用滑鼠點選，輸入第一個欄位中字母。 

快速找到和呈現參考文獻 

1. 找到作者為 Argus 的參考文獻，接著在 Argus 字母上點一下，即可選取

該筆參考文獻。您可以開啟、編輯、複製、刪除所選取的參考文獻 
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2. 按鍵盤上的 enter 鍵或滑鼠左鍵點兩下即可開啟您所選擇的參考文獻 

3. 開啟參考文獻後，會出現參考文獻的詳細資料視窗 

 

標題列 關閉按鈕 

展開或隱藏參考文

獻中的空白欄位 

4. 在此視窗中，您可以輸入或編輯資料。視窗上方的標題列：Argus, 1993 #34 
是EndNote用於查找Library中該筆參考文獻的資訊。 

5. 在瀏覽參考文獻時，可以利用滑鼠往下拉，或是利用TAB鍵往前，利用

SHIFT+TAB鍵往後。 

關閉參考文獻 

1. 點選視窗右上角的close按鈕，即可關閉參考文獻視窗 

2. 或者從 File 中選擇 Close Reference (CTRL+W) 來關閉參考文獻視窗 

3. EndNote會自動儲存您對該筆參考文獻所做的改變。 
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儲存參考文獻到群組中 

在 EndNote Library 左方的視窗會列出所建立的群組，右方視窗則呈現該群組下

所儲存的參考文獻。在一個新的 EndNote Library 中，您只會在左方視窗看到 All 
Reference 的群組，右方視窗則會列出所有儲存在此 Library 下的參考文獻。每個

Library 最多可以建立最多 500 個群組。 
Custom group，建立依照特別加入個別參考文獻到群組的功能。Smart group，自

動收集和建基在檢索測策略。 
Sample Library 已經有一些客製化群組和參考文獻。點選左方視窗在 Custom 
Groups 下的群組名稱，即可看到該群組下的參考文獻。然後再點選 All 
References，則就會再呈現 Library 所有的參考文獻。 
 
建立一個新群組和增加參考文獻 
1. 從 Groups 選單→選擇 Create Group(或是在 Custom Groups 下點滑鼠右鍵，

之後在選單中點選 Create Group)。在群組視窗，新建的群組會呈現 New 
Group 的反白字樣，您可以編輯輸入要建立的名稱 

2. 群組名稱請輸入 Geology，接著請按下 Enter 或點選參考文獻清單區域即可

儲存。目前參考文獻清單區域呈現空白，原因是目前這個群組還沒有儲存任

何參考文獻 
3. 點選 All References 群組 
4. 在 Journal 欄位中尋找前兩個期刊名稱為 Sedimentary Geology 的參考文獻，

並且利用鍵盤 CTRL 鍵 反白文獻 
5. 利用拖曳功能將反白的這兩篇文獻拖曳到 Geology 群組下。(或是從 Group

選單→Add References To→Geology 即可加入。) 
6. 點選 Geology 群組即可呈現所加入到該群組下的兩筆參考文獻 
7. 若要回到看見所有參考文請點選 All Reference 即可 
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刪除一個群組 
1. 點選群組名稱 Geology，點選滑鼠右鍵，在選單中選擇 Delete Group 即可刪

除 
2. 點選 Geology 群組。從 Groups 選單→Delete Group 
此刪除功能只會刪除群組，不會刪除掉在此 EndNote Library 的參考文獻。 

相關章節 

以下的章節提供更詳細關於第二章的資訊 
� 您可以在英文手冊第四章瀏覽更多關於改變 Library 視窗呈現方式 
� 您可以在英文手冊第八章瀏覽更多排序 Library 方式 
� 您可以在英文手冊第九章學習更多關於建立、管理群組的說明 
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第三章：設定 EndNote 偏好設定 

在此章節將介紹您學習 
� 呈現 EndNote Preferences 
� 設置每次開啟 EndNote 程式預設自動開啟的 Library 
� 改變呈現字型 

開啟 Sample Library 

如果 EndNote 還未執行請開啟 EndNote 程式，並且開啟 Sample Library 檔案。請

見第 17 頁說明。 

進入 EndNote Preferences 

從 EndNote 程式中的 Edit→Preferences 

設置 Default Library 

您可以自己設置當進入 EndNote 程式後，自動開啟 Default Library。現在我們以

設定 Sample Library 為預設自動開啟的 Library 為例子。設定步驟如下： 
1. 從視窗最上方點選 Edit → Preferences 
2. 跳出 EndNote Preferences 視窗，在視窗的左邊選項中選擇 Libraries 
3. 下一步請在 When EndNote starts 的下拉選單中選擇”Open the specified 

libraries” 
4. 接者點選 Add Open Libraries，此時 Sample Library (Sample_Library.enl)會

出現在視窗上方 
5. 點選套用儲存此改變 
6. 點選確定後，系統會自動儲存並離開 EndNote Preferences 偏好設定視窗。 
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改變 Library 呈現字型 

下一步選擇在 Library 視窗和參考文獻視窗呈現不同字型。 
1. 從視窗最上方點選 Edit → Preferences 
2. 跳出 EndNote Preferences 視窗，在視窗的左邊選項中選擇 Display Fonts 

Library Display Font 將決定在 Library 視窗中參考文獻清單的字型和大小。 
General Display Font 將決定在 EndNote 內文的字形和大小(例如參考文獻或

是 Style 視窗)。General Display Font 也適用於當參考書目直接從 EndNote 列

印或是複製時，在預覽視窗呈現的字型和大小。 
3. 在 Library Display Fonts 功能下，選擇 Change Font 按鈕 
4. 從字型清單中選擇 Arial Unicode MS(或是其他字型)，點選確定儲存欲改變

的字型 
5. 在 General Display Font，選擇 Change Font 按鈕 
6. 從字型清單中選擇 Arial Unicode MS(或是其他字型)，點選確定儲存欲改變

的字型 
7. 最後點選確定改變和離開 Preferences 對話框 
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相關章節 

以下的章節提供更詳細關於第三章的資訊 
� 您可以在英文手冊第四章瀏覽更多關於改變 Library 視窗呈現方式 
� 您可以在英文手冊第十九章瀏覽更多 Preferences 設定方式 
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第四章：輸入參考文獻 

在此章節您將學習到 

� 在Library中輸入參考文獻 

� 在參考文獻中插入圖片和檔案 

在這個單元，您可以學習如何使用參考文獻、在參考文獻中插入圖片、搜尋參考

文獻以及列印參考文獻。您也將學習如何創造和列印包含注釋的參考書目。 

開啟 Sample Library 

如果 EndNote 還未執行請開啟 EndNote 程式，並且開啟 Sample Library 檔案。請

見第 17 頁說明。 

新增參考文獻 

利用下列方法您可以新增參考文獻： 
♦ 在Reference視窗中直接鍵入參考文獻 
♦ 利用EndNote直接查詢線上書目資料庫並找到所需的參考文獻，詳細說明請

見第五章 
♦ 從線上書目資料庫或是光碟資料庫中下載參考文獻並輸入至EndNote，詳細

說明請見第六章 

開啟新 Reference 的步驟 

1. 選擇工具列中的 References → New Reference，這時會跳出 New Reference
視窗。新參考文獻視窗預設為 Journal Article 類型，您可以從參考文獻下拉

選單中選擇您所想要的參考文獻類型。 
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2. 從 Reference Type 下拉選單中選擇 Book 

 

參考文獻類型選單

參考文獻類型為：Book (書籍) 

3. 輸入作者姓名 
（1） 作者姓名有兩種呈現方式 

＊ 名在前，姓在後，例如：Carol Margaret Jacobson 
＊ 姓在前名在後，例如：Jacobson, Carol Margaret 

（2） 輸入第一作者，以 Jacobson, Carol 為例 
輸入 Jacobson, Carol 時，由於 Sample Library 中並未收錄這個作者的資料，

所以 Jacobson, Carol 會以紅色呈現。在您儲存這筆參考文獻後，EndNote

 29



會將您所鍵入的作者加到 Sample Library 的作者清單(Term List)中，加入之

後作者名稱會變成黑色。 
（3） 輸入第二作者，以 Roe, Jennifer 為例 

每個作者必須分別列在一列中。當您輸入 Roe, Jennifer 時，由於在 Sample 
Library 中已經收錄該作者名字，當您輸入 Roe 時，EndNote 會自動列出

Roe, Jennifer 的完整名字。 

 

 

4. 輸入年代及其它資料 
（1） 用滑鼠移動到下一欄位，或使用 TAB 鍵移到 Year 年代一欄，輸入 1999 
（2） 繼續在其他欄位中輸入資料，各欄位資料如下： 

Title: Impacts of meteorites on Earth 
City: New York 
Publisher: Blackcourt Press 
Number of Pages: 100 
Abstract: The impact of a meteorite hitting earth millions of years ago may 

have led to the extinction of some marine life. 

（3） 您可以使用滑鼠移動到要編輯的欄位，用 TAB 鍵往下移或利用

Shift+TAB 鍵往前移動。 
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由於這本書沒有Series Title 和 
Series Editor兩項資料，所以這兩個

欄位可以保持空白。 

關閉視窗

5. 當您完成所有欄位的編輯後，關閉視窗 EndNote 會自動儲存資料。您剛剛

編輯的這筆參考文獻會出現在 Sample Library 視窗中。 
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EndNote 可以幫助您同時組織參考文獻資訊、檔案和圖片。我們將在下面的說明

中一一為您介紹。 

在參考文獻中加入檔案 

以下是在 Journal Article 中插入檔案的說明： 
1. 在 EndNote 視窗最上方的工具列，選擇 References → New Reference，出

現 New Reference 的視窗，預設的參考文獻類型為 Journal Article 
2. 在作者、年代、標題等欄位中輸入下列資料： 

Author: Tiberius Rex 
Roe, Jenifer 
De Young, John Robert, Jr. 
University of California,, Berkeley 

Year: 2006 
Title: The scale and the feather--a suggested evolution 
Journal: Paleontology 
Volume: 3 
Issue: 1 
Pages: 125-128 
Date: November 22 
Keywords: Feathers 

Evolution 
Birds 

Abstract: This article discusses the evolution of bird feathers from reptilian 
scales. 
注意：當在 Abstract 或 Notes 欄位，您可以輸入 64K(將近 10-12 頁的文字)在
這些欄位中。 

3. 下一步，附加一個 PDF 檔案在參考文獻中。(注意：在 File Attachments 欄

位中，您可以附加任何檔案類型的檔案) 
4. 將滑鼠移到 File Attachments 欄位。 
5. 從 Reference→File Attachments→Attach File。或是在 File Attachments 欄位

中按下滑鼠右鍵同樣會出現 File Attachments→Attach File 
6. 點選 Attach File 後出現一個對話視窗，請找到在 C:\Program Files\EndNote 

X2 路徑下的 EndNote.pdf 的檔案 
7. 請注意”Copy this file to the default file attachment folder and create a relative 

link.”的勾選框是否有勾，此項目可以確保複製此檔案儲存在 Library 中。如

此，當您移動 Library 時，此檔案也會跟著您。 
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8. 點選 EndNote.pdf 的檔案→開啟 即可將此檔案附加到 File Attachments 欄位

中 
注意：在 File Attachments 欄位中最多您可以附加 45 個不同的檔案。 
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在參考文獻中加入圖片 

下一步將敎大家附加圖片。附加的圖片可以在 Microsoft Word 中被引用，我們

會在之後的章節中介紹使用方式。您可以在每個 EndNote 參考文獻附加單一個

圖片檔案。 
一個圖片檔案和一個物件檔案的差別在於如何解釋這個檔案。 
以下解釋為圖片檔案的延伸解釋： 
� BMP  Windows Bitmap 
� GIF   Graphics Interchange Format 
� JPEG  JPEG File Interchange Format 
� PNG  Portable Network Graphics 
� TIFF  Tag Image File Format 
您也可以插入物件檔案，例如： 
� Audio files (WAV, MP3) 
� Microsoft Access files 
� Microsoft Excel files 
� Microsoft Power Point files 
� Microsoft Project files 
� Microsoft Visio files 
� Microsoft Word files 
� Multimedia files (MOV, QuickTime) 
� Technical drawing files 
� Text files (TXT, RTF, HTML) 
1. 我們使用“在參考文獻中加入檔案＂中建立的參考文獻插入圖片 
2. 在 EndNote 視窗最上方的工具列，選擇 References → Figure→Attach Figure 
 
 
 
 
 
 
 
 
 
 
 
3. 在出現的 Attach Figure 視窗中 

（1） 點選 Choose File 開啟 C:\Program Files\EndNote X2\Examples 資料夾 
（2） 選擇 Feather2.BMP 並且開啟這個檔案 
（3） 在 Reference 中可以看到插入的 Feather2.BMP 圖檔 

 34



4. 在 Caption 一欄輸入 Cockatiel Crest Feathering 作為圖片說明 
5. 關閉視窗後，系統會自動儲存資料並且回到 Sample Library 視窗。 

 

 

在參考文獻中插入圖表檔案 

1. 選擇上方工具列的 References → New Reference，出現 New Reference 視窗 
2. 在 Reference Type 的下拉選單中選擇 Chart or Table 
3. 在年代、標題等欄位中輸入以下資料： 

Created By: Milkirk, Marie 
Year: 2002 
Title: Hominid Timeline 
Image Source Program: Microsoft Excel 
Date: May 9 
Keywords: Evolution 

Hominids 
Timelines 

Abstract：This article discusses the evolution of bird feathers from reptilian 
scales. 

4. 在 EndNote 視窗最上方選擇 References → Figure→Attach Figure 
5. 此時會跳出 Attach Figure 視窗 

（4） 點選 Choose File 開啟 C:\Program Files\EndNote X2\Examples 資料夾 
（5） 選擇 Hominid Evolution.xls 並開啟該檔案，之後點選 OK 插入檔案 
（6） 在 Reference 中可以看到剛剛所插入的 Hominid Evolution.xls 這個

Excel 檔 
6. 在 Caption 的欄位中輸入 Hominid Timeline 作為此一檔案的說明。 
7. 當關閉視窗後，系統會自動幫您儲存資料並且回到 Sample Library 的視窗。 
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快速知道哪些參考文獻包含檔案 

在 的標題欄中用滑鼠點一下可依此一欄進行遞增排列，再點一下會改為遞減

排列，如此您可以更快的查詢到哪些參考文獻的 File Attachments 欄位有插入檔

案(見下圖)： 

 

 

在 欄位點一下即可進行遞增排

列，再按一下會改為遞減排列 
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相關章節 

以下的章節提供更詳細關於第四章的資訊 
� 如果您想知道更多建立 Library 的資訊請參考英文手冊第四章 
� 英文手冊第五章提供您更多關於 Library 中參考文獻樣式和插入圖片 
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第五章：搜尋線上資料庫 

在EndNote的Connect和Search操作，您可以很簡易地在您電腦中的EndNote 
Library查詢線上資料庫。而且讓其更簡易使用，檢索結果將以EndNote參考文獻

格式呈現，以準備貯存在您個人EndNote Library中。 

這個章節您將學習到以下基本步驟： 

� 連結線上資料庫 

� 查詢資料庫 

� 複製參考文獻存放進入EndNote Library中 

注意：您的電腦必須有連結網路的能力。 

關於PubMed資料庫 

這個章節，您將連結到PubMed，這是由National Library of Medicine提供線上公

開使用MEDLINE資料庫的版本。PubMed是一個您可以查詢的資料庫，而National 
Library of Medicine則是它的資訊提供者。 

開啟 Sample Library 

如果 EndNote 還未執行請開啟 EndNote 程式，並且開啟 Sample Library 檔案。請

見第 17 頁說明。 

選擇連線資料庫 

1. 從EndNote視窗上方工具列中，選擇Tools → Online Search，出現Choose A 
Connection File視窗。這個視窗會列出所有的資料庫，使用Quick Search找到

所需要的資料庫 

(這個Online Search選單會將您選擇過的線上資料庫記憶在Groups中的Online 
Search，讓您更容易進入資料庫查詢。您也可以客製化您常查詢的資料庫的

清單以利查詢。) 
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點選 More 或是 Less Info 開啟或是

隱藏關於此 Connection 說明 

注意：視窗將顯示出所有的可以連結的清單，您可以使用Quick Search功能快速

查詢或瀏覽不同資料庫分類，幫助您更快找到要連結的資料庫。 

2. 選擇PubMed，點選Choose。接著會跳出Search “PubMed MEDLINE at PubMed 
(NLM)”視窗 

 

 

注意：如果您先前已經先建立了預設的檢索條件，當檢索視窗開啟時，將顯示預

設的檢索條件。若某一欄位標示為斜體字，那表示資料庫中無此一檢索欄位。 
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查詢 PubMed 資料庫 

1. 從查詢視窗的欄位下拉選單中選擇Keywords (MeSH)，從對照選單中選擇

Contains，並在後方空白欄位中輸入fossil 

 

 

 

單

2. 點選Search，EndNote會

 

3. 如果您想進行更精確的

4. 在第二個查詢欄位中輸

從對照下拉選單中選擇

索條件 

 

5. 點選Search，EndNote會

果的視窗 

 

對照選
欄位下拉選單
將檢索條件傳送到P

檢索，點選Cancel關閉

入trilobite，並且從欄

Contains，選擇布林邏

 

將檢索條件傳送到P
檢索詞
布林邏輯選單
ubMed，接著出現查詢結果視窗 

 
檢索結果視窗，回到查詢視窗 

位下拉選單中選擇Any Field，

輯AND連結第一個與第二個檢

ubMed資料庫，接著跳出查詢結
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6. 在檢索結果的視窗中點選OK，將會取得和儲存符合的參考文獻。參考文獻

將會下載到您的Library並且在All References群組中呈現和暫存在PubMed資

料庫連結群組中。 

 

 

檢查參考文獻 

您可以仔細閱讀取得的參考文獻，以確保這些參考文獻都是您想要的。您可以個

別開啟每篇參考文獻，或是利用Preview標籤快速閱讀。 

1. 點選參考文獻清單 

2. 在Tab視窗點選Preview標籤預覽參考文獻 

3. 在EndNote工具列，從Output style選單中選擇Show All Fields輸出格式。在

Preview標籤中您可以快速將選擇的參考文獻預覽各個欄位內容 
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刪除參考文獻 

1. 在PubMed群組，選擇兩篇不想要的參考文獻 

2. 從References選單→選Move References to Trash。所選擇的兩篇文獻就會從

Library中移到Trash群組 

3. 確認您要刪除文獻，先點選Trash群組，然後從References選單→選Empty 
Trash 

4. 確認後點選”確定” 

5. 點選All References群組即可回到完整參考文獻清單。若要改成其他參考文

獻格式，請到EndNote工具列，從Output Style下拉選單中選擇。 
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如果您想再回到PubMed查詢其他資料，請點選PubMed群組，輸入其他檢索策

略，點選Search。在Confirm Online Search視窗中會呈現符合筆數，並且您可以

在此視窗中勾選”Clear currently displayed results before retrieving records”選擇

是否要清除之前暫存在PubMed群組中的資料。此功能只是清除PubMed群組中

的文獻，不會影響到已經存在Library內的文獻資料。 

相關章節 

以下的章節提供更詳細關於第五章的資訊 

� 英文手冊第六章提供您關於如何建立連結查詢參考文獻和取的參考文獻 

� 請見英文手冊附錄B中的 Troubleshooting Connections，提供您當建立連結遇

到問題時的詳細說明 

� 英文手冊第十八章提供您更多關於建立和編輯Connection Files 
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第六章：匯入參考文獻資料至 EndNote 

第五章介紹大家簡易地從線上資料庫取得參考文獻，但不是所有資訊提供者都有

提供此功能。如果您從線上資料庫、大學館藏目錄或是光碟資料庫儲存或下載純

文字檔，您也可以使用 EndNote 的 import filters 匯入檔案。EndNote Filter 已經安

裝在 EndNote 中，您可以彈性地匯入想要匯入的參考文獻資料，把不要的資料消

除。在此章節中您將學習到： 
� 以 Tag 輸出格式下載資料 
� 選擇 Import Filter 和匯入資料至 EndNote 中 

開啟 Sample Library 

如果 EndNote 還未執行請開啟 EndNote 程式，並且開啟 Sample Library 檔案。請

見第 17 頁說明。 

查詢資料庫和儲存參考文獻 

通常當您查詢資料庫時，配對的參考文獻資料常以純文字檔呈現，每個書目資訊

並且都沒有清楚的指示。例如下方的例子：是來自於PubMed的參考文獻，並且

以Citation格式儲存。這個例子就是沒有清楚的指示讓EndNote區別Title、

Address、Abstract等欄位。 

Am J Med Genet A. 2005 Mar 9; [Epub ahead of print] 

Reconstructing the behaviors of extinct species: An excursion into comparative 
Sampleneurology. 

Rogers SW.  

Salt Lake City VA-Geriatrics Research, 

Education and Clinical Center and Department of Neurobiology and Anatomy, 
University of Utah School of Medicine, Salt Lake City, Utah. 

How can the behavior of an extinct species be reconstructed-say a dinosaur 
such as Allosaurus? Despite the relatively abundant fossilized remains of this and 
other dinosaurs, the incompleteness of the fossil record has permitted room for 
considerable 

speculation, mythology, and perhaps a bit of unsettling reflection on what factors 
contributed to the eventual fate of these remarkably successful animals. (continued) 

(c) 2005 Wiley-Liss, Inc. 
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PMID: 15759265 [PubMed - as supplied by publisher] 

為了有效使用這些資訊，每篇書目資訊必須一致地使用tag格式應用在正確的

EndNote欄位中。資料庫提供者提供幾種代表性地下載格式。不管您查詢哪一個

系統，您都必須以Tag格式的純文字檔儲存參考文獻。本手冊將使用先前從

PubMed資料庫下載MEDLINE格式參考文獻檔案為例子。 

PMID- 15759265 

OWN - NLM 

STAT- Publisher 

DA  - 20050310 

PUBM- Print-Electronic 

IS  - 1552-4825 

DP  - 2005 Mar 9 

TI  - Reconstructing the behaviors of extinct species: An excursion into comparative 
Sampleneurology. 

AB  - How can the behavior of an extinct species be reconstructed-say a dinosaur 
such as Allosaurus? Despite the relatively abundant fossilized remains of this 
and other dinosaurs, the incompleteness of the fossil record has permitted 
room for considerable speculation, mythology, and perhaps a bit of unsettling 
reflection on what factors contributed to the eventual fate of these remarkably 
successful animals. Among the speculations is how these 'bigger-than-life' 
creatures behaved, a topic that itself can attain equal diversity and grandeur. 
With recent advancements in measuring the relatedness of living organisms, 
how genetics contribute to brain development and how this relates to behavior, 
combined with the availability of newly discovered high quality fossils and 
imaging methods to exploit their secrets, novel insights into how extinct 
creatures such as Allosaurus intermingled with its many relatives over 100 
million years ago are beginning to emerge. (c) 2005 Wiley-Liss, Inc. 

AD  - Salt Lake City VA-Geriatrics Research, Education and Clinical Center and 
Department of Neurobiology and Anatomy, University of Utah School of 
Medicine, Salt Lake City, Utah. 

AU  - Rogers SW 

LA  - ENG 

PT  - JOURNAL ARTICLE 

DEP - 20050309 

TA  - Am J Med Genet A 

JID - 101235741 
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EDAT- 2005/03/11 09:00 

MHDA- 2005/03/11 09:00 

AID - 10.1002/ajmg.a.30538 [doi] 

PST - aheadofprint 

SO  - Am J Med Genet A 2005 Mar 9;. 

以上每一個Tag可以對應到正確的EndNote欄位。如果資料不一致或是缺少劃定界

限，這樣有可能無法正確地匯入全部的資料。 

選擇正確的 Import Filter 和匯入資料至 EndNote 

一旦您以Tag格式儲存資料，你還需要選擇適當的EndNote Filter匯入資料。在

EndNote中內建了上百筆Filter；每個Filter被設計好閱讀來自於特殊資訊提供者的

Tag格式資料。 

匯入範本純文字檔匯入至Sample Library 

4. 開啟EndNote中的Sample Library檔案 

5. 從工具列選單中選擇 File→Import 

6. 點選Choose File按鈕出現瀏覽檔案對話框 

7. 瀏覽EndNote X2\ Example資料夾中點選Pubmed-dinosaure.txt檔案 

 
8. 在從Import Option清單中選擇Other Filters呈現所有在EndNote Filters資料夾

中的所有內建Filters 

9. 輸入”PubMed”，即可跳到該Filter 

注意：在視窗下方的Comments區域給予使用PubMed網站下載參考文獻的使

用者下載小技巧。 

10. 反白PubMed(NLM) Filter選項，點選Choose 
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11. Duplicates選擇Import All；Text Translation選擇No Translation 

12. 點選Import匯入資料。當匯入完成後Library視窗只會呈現新匯入近來的參考

文獻 

 

 
13. 要重新呈現所有在Library中的參考文獻，請在Reference選單中→點選Show 

All References即可叫出所有參考文獻 
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輸出格式一覽和一致匯入選項 

下表提供一些資訊提供者和建議使用的輸出格式。此清單是為了下載適合的Tag
格式和選擇適當的Import Filter。此資訊出版時是正確的，但是如果有變更您需

要聯絡您的資訊提供者。或是也可以在EndNote官方網站http://www.endnote.com 
更新資訊。 

資訊提供者 建議下載格式 匯入選項 

AARP AgeLine 
(http://research.aarp. 
ageline/home.html) 

There is no method for downloading 
data from this database. Instead, save 
the results screen as a plain text file 
with your web browser’s Save 
command. The resulting text 
file contains tags which are preceded 
by 18 spaces. 

Ageline (AARP) 
filter   

ACM Digital Library 
(Association for 
Computing Machinery)   

Users with subscription access to 
this web site can save multiple 
records to a BINDER. Once saved, 
you can export the records in an 
EndNote format. 
Non-subscribers can download one 
record at a time:   
 1. Create a search.   
 2. Click on an article.   
 3. Scroll half-way down the page 
and select DISPLAY EndNote.   
Limitations:   
Since only plain text files can be 
imported into EndNote, you cannot 
import images, graphics, etc. Before 
importing, you may need to edit the 
file to insert a comma after corporate 
author names. Otherwise, EndNote 
will not be able to distinguish 
corporate authors from personal 
authors.   

EndNote Import  
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CSA (formerly 
Cambridge Scientific 
Abstracts)   

From the CSA search results screen, 
click Save/Print/Email. On the 
“Save/Print/ Email＂screen, select: 
Record Format: Full Record  
Save File Format: PC   
Click Save. Your Web browser asks 
where to save the file. If your Web 
browser lets you save in different file 
formats, make sure you save as a
“Text Only＂(*.txt) file.   

Various filters for 
CSA databases are 
provided in the 
EndNote Filters 
folder.   

CAS SciFinder  
Save references in the“Tagged 
Format＂(*.txt).   

SciFinder (CAS) 
filter   

Current Contents on 
Diskette (CCOD) - Mac   

Save references in the“EndNote＂ 
format.   

EndNote Import  

Current Contents on 
Diskette (CCOD) - 
Windows   

Save references in the“EndNote＂

format. 
EndNote Import  

DIALOG   

Set your communication software's 
option to capture text. Use Dialog's 
Format 5 with "tag" appended to the 
TYPE command --type "s1/5/1-20 
tag".  
You must download data in Format 
5. If Format 5 is not available, try 
the“full＂format, which is 
sometimes the same as Format 5. For 
questions concerning Dialog’s many 
formats, please contact Dialog's tech 
support. 

Various DIALOG 
filters are 
provided in the 
EndNote Filters 
folder.   

DIMDI   
Use the DLOAD command with 
report D1 (e.g. DLOAD 
REPORT=D1). 

Various DIMDI 
filters are 
provided in the 
EndNote Filters 
folder.   
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EBSCOhost   

After adding your selected 
references to your folder, click 
“View Folder＂or“Folder has 
items＂to see its contents.  
If you choose to email or save the 
references, uncheck the boxes to 
include HTML and PDF; also make 
sure that“Standard Field Format＂ 
is checked and set to “Detailed 
Citation and Abstract.＂ 
If you choose not to save to disk, 
you must also check the 
Bibliographic Manager tab, then 
choose“Citations in a format that 
can be uploaded to bibliographic 
management software＂or
“Citations in Direct Export 
format.＂   

Various EBSCO 
filters are 
provided in the 
EndNote Filters 
folder.   

EDINA   

Use the“Name＂format, where 
data is tagged with words such as
“Author＂rather than“AU.＂
Because there are so many different 
formats used for source data, you 
may need to manually edit source 
data after importing. 
EndNote cannot parse author names 
that are not clearly delimited, such as 
“S Hughes B Reynolds S A Bell & 
C Gardner.＂You will need to 
manually edit author names.  

Various EDINA 
filters are 
available in the 
EndNote Filters 
folder.   
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Emerald   

Display the marked list, click 
“display for download (ASCII),＂ 
and then save as a plain text file.   
The filter provided works for these 
Emerald databases:   
Emerald Management Reviews at 
http://www.emeraldinsight.com/revs/
Computer Abstracts International 
Database at 
http://www.emeraldinsight.com/caid  
International Civil Engineering 
Abstracts at 
http://www.emeraldinsight.com/icea/  
Computer & Communications 
Security Abstracts at 
http://www.emeraldinsight.com/ccsa/
Current Awareness Abstracts at 
http://www.emeraldinsight.com/caa/  
Limitations:   
Page numbers are separated by a 
hyphen with spaces on either side of 
it. You will need to manually remove 
the spaces after importing.   

Emerald filter   

InfoTrac (Gale)   

From the E-Mail Delivery panel at 
the bottom of the marked list 
window, restrict the contents to
“citation;＂do not choose“full 
article.＂ 
Limitations:   
Records often have extraneous 
information in the title field, which 
must be removed manually after 
importing.   

InfoTrac (GALE) 
filter   

INIST   

1. Click the Enregistrer button. 
2. Select the records you wish to 

download.  
3. Under “Quels champs?＂ 

choose "Tous les champs."  

Various INIST 
filters are 
provided in the 
EndNote Filters 
folder.   
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4. Under“Incluez＂choose 
"Numéro de notice et nom de la 
base de données" and "Libellés 
abrégés."  

5. Click the Sauvegarde de notices 
button.   

 INNOPAC   
 Save references in the 
“EndNote＂format.   

 EndNote Import  

ISI CD (Citation 
Indexes)   

From the File menu, choose Save 
Records. In the Save Records dialog, 
choose the NLM Medline format 
from the Export Format menu.   

Citation Indexes 
(ISI) filter   

Knowledge Finder   

Place document in the Save file, and 
select the document. Choose Export 
Selected Documents from the File 
menu.   

Various 
Knowledge Finder 
filters are 
provided in the 
EndNote Filters 
folder.   

Library of Congress 
Save references in the Tagged 
Format as a plain text (*.txt) file. 

OPAC(LoC) filter 
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Medscape   

After selecting the desired records 
and adding them to your clipboard, 
click the Save or Email Clipboard 
link. Save or email your clipboard in 
PC or Mac MEDLARS format as a 
plain text (*.txt) file.   

MEDLINE 
(Medscape)  
filter   

NERAC   Save your file as plain text (*.txt).  NERAC   

OCLC FirstSearch   
 

Mark those references to be saved 
and click Export. At the next page, 
choose EndNote and then click 
Export. EndNote will prompt you to 
select the corresponding filter.   

Various OCLC 
filters are 
provided in the 
EndNote Filters 
folder. 

Ovid   

After selecting the references you 
wish to download, click Results 
Manager. Choose the following 
options:  
Fields: Complete Reference Citation 
Format: Reprint/Medlars (or Direct 
Export, if available) 
Click the Save button. Save the file 
as plain text (*.txt).   

The appropriate 
Ovid filter will be 
selected 
automatically 
when using Direct 
Export option. If 
you are using 
Ovid's multiple 
database 
searching, you 
must select the 
Direct Export 
citation format.   

Ovid for Windows   

Select the Options button from 
within the "Save Documents" dialog 
box. From the list of options, choose 
the Output Format, then click OK. 
On the next screen, choose Reprint 
Format.   

Various Ovid 
filters are 
provided in the 
EndNote Filters 
folder.   
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ProQuest   

1. Select the desired references and 
then click the“My Research 
Summary＂tab.  

2. Click the“Documents and 
Bibliography＂tab.  

3. Choose“Export,＂then either 
“Export directly to ProCite, 
EndNote or Reference 
Manager,＂or“Download in a 
format compatible with ProCite, 
EndNote, Reference Manager 
and RefWorks.＂If you choose 
the former, make sure your data 
is displayed in a tagged format 
before saving as a text file.   

 ProQuest filter  

PsycINFO 
http://www.apa.org  

After marking the records you wish 
to download, choose Full PsycINFO 
Record then click the Display 
Marked Records button. Select the 
text, then copy and paste it into a 
text editor, saving the file as plain 
text (*.txt).   

Use the PsycINFO 
(APA) filter.   

PubMed   

From the drop-down list next to
“Display,＂choose MEDLINE. 
From the“Send to＂list, choose 
File. Use your browser to save the 
page as a plain text file (*.txt). 
You can check current download 
instructions for NLM PubMed at any 
time at http://www.pubmed.gov.  

PubMed (NLM) 
filter   
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SilverPlatter WebSPIRS  

Once you've obtained your search 
results, click Save. Select the 
following“Save Records＂ 
options:  
Which fields?: All fields   
Include: Record number and 
database name   
Field labels: Short labels.   
Click the Save Recordsbutton. Use 
your Web browser to save the page 
as "Text Only" (do not save in 
HTML format).   

Various 
SilverPlatter filters 
are provided in the 
EndNote Filters 
folder.   

STN   
 

Set your communication software’s 
options to capture text to a file. Type 
the command“Display All＂.   
 

Various STN 
filters are 
provided in the 
EndNote Filters 
folder.   

UnCover (Ingenta)   
Using your email software, save 
references emailed to you as a "Plain 
Text" or "Text Only" file.   

UnCover 
(INGENTA)   

VHL (Virtual Health 
Library)   

1. After selecting the desired 
references, scroll to the bottom 
of the page and click “Your 
collection＂(or“Su 
selleccíon＂).  

2. Cancel the print dialog, and then 
save the screen as a plain text 
file.  

Various VHL 
filters are 
provided in the 
EndNote Filters 
folder.   

Web of Science   

Display your marked references. 
Then, look under Output Records 
and select the option to output Full 
Records. Next, click Export to 
Reference Software to have the 
references exported directly to 
EndNote. You may also choose Save 
to File to save the references to a 
text file and import them into 
EndNote.   

ISI-CE filter 
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Wilson   

Select the following options 
Destination: Choose e-mail or save.  
Include: Record numbers and 
full-text links (optional).  
Format: Choose text.   

WilsonWeb filter 

WorldCat 
(OCLC FirstSearch) 

1. Mark those references to be saved 
and click Export. 
2. Choose Text File. 
3. Click Export. 

WorldCat (OCLC) 
filter 

 

從網頁直接輸出 

某些網站包含一個下載按鈕，將傳送您的檢索結果至EndNote中，選擇正確import 
filter和開始自動匯入。所有的步驟您只要選擇哪一個EndNote Library要儲存匯入

的資料。這個 ”direct export” 或是 ”direct download” 方法廢除額外儲存參考文

獻為純文字檔的步驟和匯入檔案選擇適當的import filter。 

以下系統清單提供直接輸出參考文獻至EndNote。更詳細的介紹表格可以參考原

文完整手冊中的附錄D。以下清單會一直不斷成長，請在EndNote官方網頁上

http://www.endnote.com 確認最新資訊。 

 

� ALEPH 

� American Psychological Association, PsycInfo Online 

� Bibliotech.dk 

� BioMedCentral 

� BioOne 

� Blackwell Synergy 

� BMJ 

� Buffalo University 

� CABI-Direct 

� Canadian Journal of Communication 

� CCLR 

� Delphion 

� EBSCO 

� EI Engineering 
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� Elsevier 

� EMBASE 

� ERIC 

� ESDS Government 

� Google Scholar 

� HAPI 

� IEEE 

� JAMA 

� JISC 

� JSTOR 

� Karger Publishing 

� Los Alamos National Laboratory 

� MicroPatent 

� Nature 

� Nerac 

� NISC 

� OCLC 

� OhioLink 

� OVID 

� Oxford Press Journals 

� Pacific Northwest Labs 

� Patent Cafe 

� PILOTS 

� PNAS Online 

� ProQuest 

� RLG 

� Science Magazine 

� Scopus 

� St. John of God, Ireland 

� Stanford University's Highwire Press 

� Telemed 

� Thieme 

� Web of Science 

� WebFeat 
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� WilsonWeb 

相關章節 

以下的章節提供更詳細關於第六章的資訊 

� 英文手冊第七章提供更多關於匯入選項和從其他書目軟體程式匯入參考文

獻說明。 

� 英文手冊第十七章將學習如何建立或修改Filter以符合下載的參考文獻對應

到EndNote中正確的欄位。 

� 參見英文手冊附錄D，提供詳細表格介紹從不同線上系統匯入參考文獻資料

的說明。 
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第七章：查詢 EndNote Library 和直接從 EndNote 列印 

這個章節將引導您學習： 

� 查詢EndNote Library中的參考文獻 

� 從EndNote中列印獨立的書目資料 

在本手冊中，您將查詢一套相關參考文獻和列印參考文獻，好像與同事分享資訊。 

開啟 Sample Library 

如果 EndNote 還未執行請開啟 EndNote 程式，並且開啟 Sample Library 檔案。請

見第 17 頁說明。 

查詢參考文獻 

讓我們假定您想從Sample Library產生年代從1990年~1999年出版關於extinction
方面相關的參考文獻清單。 

查詢參考文獻 

1. 先確認All Reference群組中的所有參考文獻都呈在Library視窗中 

2. 在Library中請到Tab視窗中點選Search標籤 

3. Search標籤將會記憶您上次輸入的檢索策略，若要清除請點選Options按鈕，

點選Restore Default 

 

4. 在第一個欄位輸入檢索詞 ”extinct”。接著選擇Any Field，EndNote會查詢任

何欄位中有關於extinct的參考文獻。接著選擇Contains，意指EndNote會查詢

這個欄位中任何地方。下一個步驟建立查詢從1990到1999年的參考文獻 

5. 在第二個欄位輸入檢索詞1990，從欄位下拉選單中選擇Year欄位，並且從對

照下拉選單中選擇is greater than or equal to 
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6. 如果查詢頁面中您還未看到第三個欄位，請點選 按鈕加入 

7. 在第三個欄位中輸入檢索詞1999，從從欄位下拉選單中選擇Year欄位，並且

從對照下拉選單中選擇is less than or equal to 

8. 注意在每一個查詢欄位末端都有And、Or、Not布林邏輯選單。在這三個欄位

末端請都選擇布林邏輯And。 

您的查詢視窗會呈現如下圖： 

 

對照選單

檢索項目
布林

邏輯 

欄位選單 

此查詢將會找到所有參考文獻中有包含”extinct”，同時也是在1990年到1999
年間出版的文獻。 

注意以下兩個勾選框不在此次的檢索範例中查詢： 

Match Case： 

這個選項將限制您的檢索辭彙”extinct”為小寫字母。如果在句子開頭找到大

寫或是所有都是大寫字母，EndNote將不會搜尋到。 

Match Words： 

這個選項將限制檢索到完全符合”extinct”的辭彙，它不使用切截功能。所以

例如字彙”extinction”不會被搜尋到。 

9. 點選Search按鈕開始查詢。立即EndNote呈現符合的檢索結果 

在Library視窗底端呈現找到的檢索結果筆數”Showing 7 of 7 references in 
Group”。EndNote限制瀏覽僅呈現您所檢索到的結果資料。您可以點選作者欄

位標題，依照作者姓名排序。現在您可以選擇您想要的文獻，並且準備列印

它們。 
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預覽和列印找到的參考文獻 

為了要格式化您的參考文獻，您必須要選擇一個Style。Style決定您的參考文獻在

列印、輸出、預覽或建立書目時呈現的方式。 

當您可以直接列印，也許您想儲存成RTF檔案替代。一個RTF檔案可以以任何文

書處理器開啟， 

預覽書目 

1. 在主要工具列中，從輸出格式清單中選擇一個輸出格式。例如：選擇Numbered
格式 

 

 

2. 從File選單→選擇Print Preview在您的電腦銀幕中呈現書目 

3. 您可以利用視窗頂端的按鈕功能預覽書目 

4. 當您預覽完畢後，點選關閉即可關閉預覽功能 
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儲存書目為文書處理檔案 

1. 在主要工具列中，從輸出格式清單中選擇一個輸出格式。例如：選擇

Author-Date格式 

 

2. 從File選單→選擇Export。將會出現另存新檔視窗 

3. 選擇存檔路徑位置和輸入檔名 

4. 在存檔類型的下拉選單中選擇Rich Text Format(*.rtf) 

5. 點選儲存，儲存檔案 

6. 您可以用任何文書處理器像Microsoft Word、WordPerfect等開啟RTF檔案。您

也可以在文書處理器中修改或是列印資料 
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列印書目 

1. 在主要工具列中，從輸出格式清單中選擇一個輸出格式。例如：選擇Numbered
格式 

2. 從File選單→選擇Print。會出現一個列印對話視窗 

3. 點選確定即可列印 

相關章節 

以下的章節提供更詳細關於第七章的資訊 

� 英文手冊第八章提供更多關於查詢EndNote Library的資訊。 

� 英文手冊第十三章提供直接從EndNote Library建立參考文獻清單。 

� 英文手冊第十六章提供更多關於修改和選擇格式說明。 
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第八章：在 Microsoft Word 中使用 EndNote 撰寫文章 

EndNote 的 Cite While You Write 特色插入 EndNote 指令在 Word 工具選單中，當

您在使用 Microsoft Word 撰寫文章時，直接進入您的參考文獻。Cite While You 
Write 指令可以讓 EndNote 在您目前開啟的 Word 中做書目格式功能。在此章節

中，您可以學習在 Microsoft Word ( 2003 或 2007)中使用 EndNote 的參考文獻，

和如何插入引文、圖表。 

開啟 Sample Library 

如果 EndNote 還未執行請開啟 EndNote 程式，並且開啟 Sample Library 檔案。請

見第 17 頁說明。EndNote 將會搜尋在已經開啟 Library 中適合的參考文獻。 

在 Manuscript Template 中創造新文件 

Manuscript Template 讓您更簡單的建立您的論文電子檔案格式給出版社。假設

您寫了一篇關於 Evolution 的論文，要投稿至 Nature 這本期刊。 
1. 從 EndNote 工具列 Tools 中選擇 Manuscript Templates 
2. 出現 Manuscript Templates 視窗，選擇 Nature.dot，點選開啟 
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注意： 

(1) 如果您是第一次使用 Manuscript Template Wizard，您會收到一個巨集

的安全性警告畫面。請選擇接受巨集，勾選”總是這個來源的巨集” → 
開啟巨集。 

 

 

(2) 如果您使用的是 Word 2007，您必須使以下方式開啟巨集。 

點選”選項” 

 

 
 
點選”啟用這個內容”→”確定”即可出現 EndNote Manuscript template wizard 視窗 
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3. 出現 EndNote Manuscript template wizard 視窗，點選下一步(Next) 
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4. 輸入撰寫文章的篇名：Theories About Evolution，點選下一步(Next) 

 

 

5. 輸入該篇文章的作者姓名，首先選擇 Add Author，在出現的視窗中點選

New，依序輸入作者姓名及相關資料，輸入完點選確定(OK)，您所輸入的

作者會建立在 Author List 中，以同樣方式可再建立其他作者資料，建立好

所有作者資料後選取該文章之作者，然後按下 OK，點選下一步(Next) 
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6. 勾選這篇文章中所要呈現的資料，如正文、摘要、參考文獻、圖表等，選

擇完畢後點選下一步(Next)，之後點選完成(Finish) 

 

 

7. 點選完成後，系統會開啟 Word 檔案，以及剛剛所輸入的資訊和欲呈現的資

料(如下圖)，您可開始編輯這篇文章。 

 

 

開啟一個 Microsoft Word 文件 

以下範例將以開啟一個 Microsoft Word 新文件為範例。 
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引用 EndNote 中的參考文獻 

開始撰寫您的論文和插入引文 

1. 輸入您欲撰寫的文章內容，例如： 
The fossil in question was generally regarded to be the 220 million year-old 
remains of tyrannosaurus. Several years ago, however, this hypothesis was 
overturned by the discovery of yet another species. 
現在準備插入參考文獻 

2. 從 Word 工具選單 → 選擇 EndNote X2 → 選擇 Find Citation(s) 
z Word 2003 工具→EndNote X2 選單 

 

 

z Word 2007 則是從 EndNote 標籤下使用各個 EndNote 工具列功能 

 

 
3. 接著跳出 EndNote Find Citations 視窗。在 Find 後的空格中輸入 Morehouse，

點選 Search，EndNote 會自動找出符合該條件的參考文獻。利用視窗下方可
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確定該筆參考文獻是否符合您的需求。在此範例中只有一筆資料符合。 

 

 
4. 確認無誤後將該筆文獻反白，點選 Insert 可在文章內文中插入該筆參考文獻 

EndNote 不只是插入引用文獻，也會出版目前所選擇的 Numbered 格式，也會

在文章末端出版 Numbered 格式書目 

5. 在正文中加入欲增加書寫的內文： 
It is now the undisputed progeny of the species at hand. 

6. 從 Word 工具選單 → 選擇 EndNote X2 → 選擇 Find Citation(s) 
注意：如果您使用的是 Word 2007 則是從 Endnote 標籤→Citation 群組中→點選

Insert Citation→在點選 Find Citation 即可開啟此功能。 
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7. 在 Find 中輸入 1987 並點選 Search，EndNote 會自動找出符合的參考文獻 

 

 
8. 反白作者為 Turnhouse 的參考文獻，點選 Insert 

EndNote 會插入引用文獻，並且 Cite While You Write 技術將會格式化參考文

獻和加入參考文獻在文章末端。您的文件將呈現如下圖所示： 

 

 
9. 假設您已經完成在文章中插入引用文獻的步驟。從 Word 的檔案選單中→選

擇存檔，儲存您的文件。如果您使用的是 Word 2007：點選 Office 按鈕→接

著點選”儲存檔案” 

注意：您也可以在註腳插入引用文獻。第一步，使用恰當的 Word 指令建立註

腳。Word 控制分配和給註腳數字，EndNote 會依照現有選擇 Style 格式化。您

必須要選擇有包含註腳的格式，例如：Chicago 15th A. 
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選擇書目格式 

您可以多次出版您的引用文獻和書目，每次改變不同的輸出格式和各式各樣其

他版面編排設計格式。 

選擇要出版的書目格式 

1. 從 Word 工具選單 → 選擇 EndNote X2 → 選擇 Format Bibliography 

z Word 2003 工具→EndNote X2 選單 

 

z Word 2007 則是從 EndNote 標籤→Bibliography 群組→從 Style 下拉選單中選

擇輸出格式→Update Citations and Bibliography 

 

 

一個 Format Bibliography 對話視窗出現，您可以選擇書目格式。格式將包含

EndNote 將出版的引文文獻和書目。在前一個，我們說明使用 Numbered 格式，

連續數字引文文獻和在文章末端插入數字參考文獻清單。 

同樣地您也可以看到，這裡有許多其他出版選項，您可以選擇改變覆蓋現在的輸

出格式。 
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2. 在此範例中，點選在 With output style 旁 Browse 按鈕，呈現出所有 Output Style
清單 

3. 選擇 APA 5th 格式，點選 OK 

4. 在 Format Bibliography 對話視窗中點選確定 

EndNote 將會自動將現有的引用文獻和書目重新產生成 APA 格式 

在未來，如果您需要改變文章，例如像增加或刪除引用文獻或是文章，在您的文

章中正確執行必要的更新。如果您想改變輸出格式或是書目輸出版面設置，再一

次選擇 Format Bibliography 指令即可。EndNote 將會重新出版本文中的引用文獻

和依照您所改變的產生一個新的書目。 

注意：在 EndNote 的 Style 資料夾中有超過 3000 個以上的格式。請在 EndNote
程式中從 Edit 選單→選擇 Output Styles →選 Open Style Manager，可以看到所有

格式清單。 

編輯引用文獻 

如果您直接編輯一個引用文獻或是書目，當再次點選 Format Bibliography，

EndNote 將會依照選擇的輸出格式重新出版。去做和保留改變所有引用文獻或書

目修改輸出格式。然而，您想個別改變引用文獻，則是使用 Edit Citation 指令。 
對於一些書目格式，多數的參考文獻是以 Author, Date 格式呈現，但是作者名字

被提及在文章內，格式則會下指令命令名字不會重複在引用文獻內。例如在我們

的範例中，在文章內提到 Morehouse，所以我們移除這個引用文獻作者名字。 
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我們也想在特殊的引用文獻加入參考文獻頁碼。 

編輯個別引用文獻 

1. 將滑鼠點選在 Morehouse 引用文獻上 
2. 從 Word 工具選單→選擇 EndNote X2→選擇 Edit Citation 
注意：如果您使用的是 Word 2007 則是從 EndNote 標籤→Citation 群組→Edit 
Citation(s) 

 

 
 

 

 
3. 在 Formation Citation 中勾選 Exclude author 
4. 在 Pages 中輸入 34-35 

注意：在 Pages 框中輸入引用數字，不保證它會出現在您的引用文獻中。您

必須從輸出格式清單中選擇使用在 Citation Template 中有 Cited Pages 欄位的

輸出格式。您也可以修改任何輸出格式包含此欄位。 
5. 點選 OK 更新 Word 中的引用文獻 
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插入引用圖表 

下一步您將要插入兩個圖表引用文獻，一個是圖片，一個是表格。這個章節插入

的資料來自於第四章所建立的參考文獻。 
所有圖表引用文獻插入方式都相同；EndNote 的參考文獻類型決定是否插入和編

號是圖和是表。 

找到和插入圖片引用文獻 

1. 首先在文章中對於欲插入的圖表做一說明，例如： 
As researchers look at evidence, even the crest on the modern cockatiel provides 
insight into the evolution of feathers. 
現在您可以準備插入圖表引用文獻 

2. 從 Wor 中的工具選單→ EndNote X2 → Find Figure(s)，接著跳出 EndNote 
Find Figure 對話視窗 

注意：如果您使用的是 Word 2007 則是從 EndNote 標籤→Citatin 群組→點選 Insert 
Citation→點選 Find Figure 

 

 
3. 在 Find 後方空格中輸入 bird evolution，點選 Search 
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4. EndNote 會自動列出符合的文獻並顯示圖片 
5. 選擇 Caption 為 Bird Evolution 的文獻，點選 Insert 
6. EndNote 會自動將該圖片插入到正在撰寫的 Word 檔案。 

 

 
 

找到和插入表格引用文獻 

1. 首先在文章中對於您要插入的表格做一介紹，例如： 
While exploring the evolution of dinosaurs and birds, it becomes clear that Homo 
sapiens have occupied earth for a relatively short period of time. 

2. 從 Word 中的工具選單→ EndNote X2 → Find Figure(s)，接著跳出 EndNote 
Find Figure 對話視窗 

注意：如果您使用的是 Word 2007 則是從 EndNote 標籤→Citatin 群組→點選 Insert 
Citation→點選 Find Figure 
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3. 在 Find 後方空格中輸入 hominid，點選 Search 

4. EndNote 會自動列出符合的文獻和圖表，在此找到的是 Excel 格式的圖表 

 

 

5. 確認要插入的參考文獻後，點選該筆參考文獻，之後點選 Insert，即可在文章

中插入該圖表(如下圖) 

 

 

※ 從 Figure 和 Table 中可以看到剛才插入的圖表與 Excel 檔。 

 

 

※ 本範例格式使用 APA 格式。您可以重新修改圖表大小。 
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※撰寫完論文請記得 Save 儲存檔案。您可以繼續在您的論文中增加正文、引用

書目、引用圖片，EndNote 將會繼續增加文章中參考文獻清單，圖表清單，表

格清單。 

移除參數 

1. 文章完成後，從 Word 檔案→ 儲存檔案，即可儲存該篇具有 EndNote 參數

文章。 

2. 如要移除參數，從 Word 中的工具選單→ EndNote X2 →Remove Field Codes 
接著出現是否要儲存具有 EndNote 參數檔案的對話框。 

注意：如果您使用的是 Word 2007 則是從 EndNote 標籤→Bibliography 群組→

Convert Citations and Bibliography→Convert to Plain Text 

 

3. 儲存完畢後會跳出沒有 EndNote 參數的 Word 檔，即可移除完畢 

相關章節 

以下的章節提供更多詳細關於第八章的資訊 
� 如果您想知道更多關於引用參考文獻、圖片和使用 Cite While You Write 建

立參考書目，請見英文手冊第十一章 

� 超過3000個style在EndNote Styles資料夾中。您可以從EndNote中點選Edit → 
Output Style → Open Style Manager看到style清單。詳細資訊請參考英文手

冊第十六章 

� 英文手冊第十六章有包含編輯輸出格式的介紹 
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第九章： 建立一個主題書目 

� 在這個單元，將教您如何利用各欄位建立和列印一個參考書目群組，例如使

用關鍵字、期刊題名等。 

開啟 Sample Library 

如果 EndNote 還未執行請開啟 EndNote 程式，並且開啟 Sample Library 檔案。請

見第 17 頁說明。 

選擇包含的參考文獻 

1. 建立一個您想要包含參考文獻的主題參考文獻 
2. 從您開啟的 EndNote Library 中之參考文獻清單作一個匯編清單的工作 
3. 您可以限定查詢清單中的參考文獻，或只顯現出所選擇的參考文獻。例如，

我們將包含所有的參考文獻在 Library 中 
4. 確定所有的參考文獻都有顯現。從 EndNote →  Reference →  Show all 

Reference。如果 Show all Reference 呈現無法選取，則表示 EndNote Library
已經呈現所有參考文獻了 

選擇主題欄位和詞彙 

1. 從 EndNote Library →  Tool →  Subject Bibliography →  呈 現 EndNote 
Library 中的主題欄位 

2. 將 Keyword 選取反白 
您可以選擇單一欄位或是選擇結合幾個欄位，但通常多選擇由關鍵詞欄位去

建立主題書目。 

3. 點選 OK，顯示利用關鍵字欄位所找到的詞彙 
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4. 您可以選擇任何您想點選的詞彙，在此例子中我們選擇所有關鍵字。選擇

Select all 的按鈕 

 

 
5. 點選 OK，用關鍵字分析的主題書目就會呈現在螢幕上 
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關鍵字

主題詞數量 

改變書目輸出格式 

1. 您可以在主題書目畫面的上面 Output Style 下拉選單中選擇不同的輸出格

式。在這個例子中，選擇 Author-Date，主題書目將會更新成我們所選擇的新

格式。您也可以選擇 Select Another Style 選擇 3000 多筆不同的輸出格式。 
2. 點選 Layout 按鈕，您可以修改輸出和主題書目格式 
3. 在 Reference 項目中，可以改變 Reference List Title 為 Reference 或其他希望出

現的標題文字。這個標題就是列印時書目上的標題。您也可以改變每筆參考

書目排序的方式 
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4. 在 Terms 項目中，有幾個項目我們可以修改選項 
（1） Reference List 

您可以選擇 Subject Terms Only，將會只有呈現主題標題，不會呈現參考文

獻格式。選擇 Subject Terms and Reference List，將會呈現主題標題和參考文

獻格式。在此例子中我們選擇 Subject Terms and Reference List 和 Recycle 
Numbering。勾選 Recycle Numbering，當數字型參考文獻有修改時，也會跟

著修改。 
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（2） Include 
在此項目中，您可以勾選 Subject Term Counts 呈現主題詞彙的數量，或

勾選呈現主題記錄 ID 號碼。 
（3） Subject Term Layout 和 Styles：主題詞輸出排序和字體樣式 

5. 在 Bibliography Layout 項目中，Author-Date 輸出格式在參考文獻的編排上沒

有嵌入空格。請選擇 End each reference with 的下拉選單中，嵌入 End of 
Paragraph。 

6. 點選確定，將會儲存所改變的設定 
7. 在主題書目中我們還可以使用的功能如下 
（1） Print Preview：您可以預覽主題書目列印的樣式 
（2） Print：您可以列印主題書目 
（3） Save：您可以儲存主題書目，並選擇您想要的儲存格式 text、rtf、html 
8. 點選 Close 將會關閉主題書目視窗回到 EndNote Library 中 
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相關章節 

� 請見英文手冊第十四章提供更多第九章相關資訊 
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